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Presenter
Presentation Notes
Grasslands
(Basic)

Note: This template is optimized for PowerPoint 2010 and uses a video background. If used in PowerPoint 2007, video elements will play, but all content will be covered by video background when in slideshow. If used in PowerPoint 2003, video will not play, but the poster frame of the videos will remain in place as a static image. �
The video:
Plays automatically after each slide transition.
Is 30 seconds long.
Seamlessly loops for infinite playback.�
To add slides or change layout, do the following:
To add a new slide, on the Home tab, in the Slides group, click the arrow under New Slide, then click under Motion Background Theme select the desired layout.
To change the layout of an existing slide, on the Home tab, in the Slides group, click Layout, then select the desired layout.

This template uses the “Pushpin” Theme Font. To access or change the Theme Font, do the following:
On the View tab in the Master Views group, select Slide Master. 
In the Slide Master view, select slide 1 (the Master Slide for Master Layouts that use the video background).
On the Slide Master tab, in the Edit Theme group, click Fonts, and then select new theme fonts.

Using animated elements:
Any animated element will begin after the slide transition and the background video has started.





Soil Disturbance in a typical Organic system is
greater than a typical conventional system.

Since Organic systems typically rely on tillage for
weed control, soil loss is always higher than a
mulch-till or even a conventional system.
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< Soll Disturbance in a typical Organic system is
greater than a typical conventional system.

There are no “typical” systems, Organic, conventional
or otherwise. However, there are common activities.

< Since Organic systems typically rely on tillage for
weed control, soil loss is always higher than a
mulch-till or even a conventional system.

Organic systems rely on many practices and activities
for weed control, not just tillage. However, tillage is
the primary suppression technique.




Yes!

But, that is another presentation
altogether.

http://www.conservationwebinars.net/webinars/reduced-tillage-in-organic-specialty-crop-systems
http://www.conservationwebinars.net/webinars/organic-no-till-systems



Get the field management details
|dentify when soil loss occurs

|dentify potential mitigation alternatives
Assess the effects of those alternatives
Implement the agreed-to alternative(s)



It is essential that you know the details of the field
operations to accurately determine the soil loss
rate and to know what part(s) of the year/rotation
soil loss is most prominent.

Prepare and fertilize seed bed in the spring for sweet corn
3 with tandem disk as soon as it is dry and warm enough.
A n.ot.uncommo.n Plant in April/May. Hand pick corn in the summer. Prepare
descr|pt|on of a clients and fertilize seed bed in the spring for tomatoes with

. . tandem disk as soon as it is dry and warm enough. Lay
ﬂeld operatlons for a plastic mulch and plant. Hand pick tomatoes all summer

mixed vegetable rotation long. Prepare and fertilize seed bed in the spring for
pumpkins with tandem disk as soon as it is dry and warm
enough. Pick Pumpkin early October. Prepare and fertilize
seed bed in early May for peas. Machine harvest in July.




During the Inventory and Evaluation phase of the
Conservation Planning process, the planner must ask
about:

What the producer does (e.g. plow, disk, plant, weed,
harvest etc.)

When the producer does it (e.g. Nov 15-plow, April 1-disk,
April 15-plant, every 2 weeks after planting until canopy
closure in early June-weed, July 15-harvest, etc.)

How the producer does it (e.g. 4-bottom moldboard plow to
8” depth at a 45° angle from the western edge of the field,
tandem disk at 6” depth at 90° angle from plow direction,
tine weeder for first 2 passes then rotary row weeder after,
etc.)



b;b; Management: CMZ 60%c.Other Local Mgt Records\Corn,sweet,SD, cultivated - Tomnatoes, 50, plastic - Squash,5D - Peas, 5D, drilled;mod Z60
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Add b this management to make new one | Open How et crop year end/start? | zet by uzer j
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Baze energy use , BTU ac [ 2700000 ~lap e =l Lizp msdsy mdddy
Irrigation system | no irmigation | Base fuel cost, US$/ac 0 1 127 Coin, swest #1140 10414
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td anagement Operations
Standing
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51,1 - Mo [ Add mulch - (] b anure, poultny | 2000 13
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5/51 - Mo [ Harrowy, coiled tine -
5/10/1 i Mo [ Fert applic. surface broadcast hd
5104 - Mo [ Planter, double disk opnr ha [ Corm, sweet ~| 10000
E/1./1 ] Mo [ Cultivatar, raw 3 in ridge hd
5/15/1 ] Mo [ Cultivator, row 3 in ridge b
104141 ] Ye: [ Harvest, hand pick vegetables hd
11141 i Mo [ ‘winter kill antual crop hd 2700 B4 1800
51542 ] Mo [ Diigh, tandem heawy primary op. i
5/20/2 - Mo [ Add mulch - (] compost - 4000 93
572042 ] Mo [ Dizk, tandem secondary op. hat
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B/22/3 hd MHa Culbivatar, row 3 in ridge hd
7M/3 ha Mo Cultivator, row 3 in ridge hat
a3 hd Mo wéeed control, manual hoe b ] weeds; 0-3 mo h a0 2.6
223 ha Mo wieed contral, manual hoe hat [ weeds; 0-3 mo hat a0 26
104143 hd Mo Harvest, hand pick wegetables >
114143 hd MHa Winter kil annual crop hd 1100 47 720
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Effects of some field operation choices in RUSLE2

k anagement Operations

Date, mdddy : Operation \egetation

Change in Soil

Description Loss (%)
Tomato - benchmark -
Tomato - lighter disk 240)
Tomato - heavier disk 16
Tomato - flame weed 1st month -8
Benchmark w/ plastic mulch (50% cover) -33

|Light disk w/ plastic mulch (50% cover) -45
|Benchmark w/ plastic mulch but forget to remove it -94

http://www.conservationwebinars.net/webinars/rusle2-in-organic-systems



Gathering

For use with “NRCS

Management Questions: Select the RUSLE2 management template that best describes the summa ry ta b Ste pS
client’s crop or rotation and check each line of the record you selected and answer the 12 19 2 O 14 ” user te m p I ate

following question.  Questions are referenced on Figure 2.
Are the dates of the selected operations correct? not, make it so_
Are the operations selected in the correct order? If not, make it so. **

Are the operations selected correct? Check information by clicking the yellow
folders for details. What you are looking for here is that, for example, if a farmer is using

a “tandem disk™ ensure that the implement operation depth and residue burial value

observed in the field operation is the same as that stated in the “tandem disk™ record you
choose from the RUSLE2 database. ** B i e S e E

e Daesbe L3t Opticra Toch Windos Help
CETRN O N DA

Is/are the correct vegetation(s) selects (see 6. for more detail)

Is/are the yield(s) reported in the RUSLE2vegetation record and the field yiel
consistent? =

Is the correct vegetation record selected? ] an be checked by gra
Y%canopy of the vegetation selected and matching 1t up with the vegetation mn t
Note: vegetation records have a % canopy value for each day of the record a
associated total yield value. ging the yield value will change canopy valy

Is the field irrigated? res, enter irrigation information in the
management record if you are modeling an irrigated crop.

B Pt K CR

Similar information
needed for WEPS


Presenter
Presentation Notes
A document exists that helps a new RUSLE2 user to gather all the information that is needed to create an accurate management record for a RUSLE2 analysis.  A copy of this file can be downloaded from the Adobe Presentation Site or later from the Webinar page.
Sheet 1:  General questions – Profile window
Sheet 2:  Management questions – Management window
Sheet 3:  Details – Profile window (Step 1 tab cons. pract., rock cover)
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File Database Edit View Options Took Window Help
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MRCS summary tab steps 12192014 [E] MOSES MEW FORAGE FY15
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Soil Conditioning Index (SCI):

A quick way to characterize the organic matter dynamics of a
farming system.

OM is the organic material or biomass factor.

FO is the field operations factor.

ER is the erosion factor.

Soil Tillage Intensity Rating (STIR):

Value reflects the kind of soil disturbance as well as the
severity of the disturbance caused by tillage operations.
Operational speed of tillage equipment
Tillage type
Depth of tillage operation
Percent of the soil surface area disturbed


Presenter
Presentation Notes
Soil Conditioning Index (SCI):  SCI = 0.4*OM + 0.4*FO + 0.2*ER
OM is the organic material or biomass factor.
FO is the field operations factor.
ER is the erosion factor.



Mitigating offsite soil loss impacts (i.e.
sediment delivery)

< Field Border
 Filter Strip = L
« Riparian Forest Buffers
<« Sediment Basin

< Grassed Waterways



Other soil loss mitigating techniques

< Strip crop

< Diversions and Terraces
< Mid-slope buffers
< Contour farming
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Cons. Plan. Soil

Soil Loss, |Sed. Delivery, | Conditioning
Description t/ac/yr t/ac/yr Index (SCI)
Benchmark Condition 71.67 7.67 -0.48
Sediment Basin at the Bottom 7.67 0.562 -0.48
Planting on the Contour 4.07
|Planting on the Contour & strip cropping 3.00
|Planting on the Contour & midslope diversion 1.94
|Planting on the Contour & midslope buffer 2.39
|Planting on the Contour & filter strip 0.471



Presenter
Presentation Notes
Soil Conditioning Index (SCI):
SCI = 0.4*OM + 0.4*FO + 0.2*ER
OM is the organic material or biomass factor.
FO is the field operations factor.
ER is the erosion factor.



Mitigating in-field soil loss

Change timing of tillage events
Switching from Fall to Spring tillage

Incorporate Cover Crops in the rotation

Look for times when there is little cover or residue in the
field

Look for opportunities to grow cover crops simultaneously
with cash crops

Incorporate more high residue cash crops in the
rotation

Strip cropping with perennial hay crop in the rotation



E1. RUSLE? Version 2.5.4.8 (Apr 8 2015)
File Database Edit View Options Took Window Help

HE % LRI E R =YY I R
[iinis UEieny E= == & Slope soll loss for cons plan, t/ac/day - NE demo SLOPE
Ao brek Actual row arade, %
Crit. slope length, f 3
T value, tachn [ 30| 24
. 18
@
= 12
g I | |
Soil loss for cons, plan. t/ac/r SCl walue 0K [N = 06 |
SR A e [ TN i [
y T 1 T 1 T U T
Met event unoff, indpr [ 90| Siailloss for cons. plan 0K [ #%51‘1 10/251  4126/2  10/26/2 412713 1012773 4/28/45010/28/4
Avg ann. forage harvest, Ib/ac 0|
Simulation day (4/25/1 - 4/24/5)
Stipcropping | Track Biomass | Detailed Erosion Resuls | Misc. Output | Information | Hpdrolagy |
Step 1-PRIMARY INPUTS I Step 2-Soil 1 Step 3 -Topography Diversion and Tenace Location 1
Man. strip bilder Adjust yields Fuel type for entire nn 1
ﬁ Live biDJ ass, Ib/ac - NE demo SLOPE
Rictstion buider Giesral iskd level Adfust et res. sdldiion
Slope Management ]
Seq length Sl loss. Sed,
Segment Management (along oy Geiven.
slope], ft & tfacdyr
1 [[7...cal Mgt Records\Corn.sweet. 5D cultivated - Tomataes. 5D plastic - Squash.5D - Peas SO diledmad260 -] 200 | 77 [ 7.7
k4
T T T 4 T
5/ 10/2511  4/26/2  10/26/2  4/27/13 101273 4/28/4 || 10/28/4
Simulation day (4/25/1 - 4/24/5)
& Total sulf res, Ib/ac - NE demo SLOPE [z |[=]
& Profile: Soil conditioning index (Soil conditioning index(11) of NE demo = =R 4001
Wind & rigalioninduce 0] 3204
2400
SCI OM subfactor | 0,070 & 1600
SCIFO subfactor o]
SCIER subfactor = 30

o I slaps STIR
HEh Gl B2 42511 101251 4/26/2  10/26/2  4127/3  1027/3  4/28/4  10/28/4
Sl conditianing index (SCI)

Annual STIR Yalue by Crop Year _
Start date,  End date,
e Veg STIR value
I I [ [
FHNYiY 17

Simulation day (4/25/1 - 4/24/5)

MRCS summary tab steps 12192014 [E] MOSES MEW FORAGE FY15

R2 NRCS Fld Office




Original Corn-Tomato-Squash-Peas Rotation

Cons. Soil
Plan. Soil| Sed. Cond.
Loss, |Delivery,| index
Description t/ac/yr | t/ac/yr | (SCI)
7.67 7.67 -0.48

Benchmark Condition (Original Corn-Tomato-Squash-Peas Rotation)

Added cover crops

Added cover crops & contouring

Added cover crops & contouring & additional 1T compost




Alternative Corn-Tomato-Squash-Cabbage Rotation

Cons. Soil
Plan. Soil| Sed. Cond.
Loss, |Delivery,| index

Description t/ac/yr | t/ac/yr | (SCI)

-0.48

Benchmark Condition (Original Corn-Tomato-Squash-Peas Rotation) 7.67 7.67

Added cover crops & replaced peas with cabbage

Added cover crops & contouring & replaced peas with cabbage
Added cover crops & contouring & replaced peas with cabbage & additional 1T
compost




Alternative Corn-Tomato-Squash-Sorghum(hay) Rotation

Cons. Soil
Plan. Soil| Sed. Cond.
Loss, |Delivery,| index
Description t/ac/yr | t/ac/yr | (SCI)
Benchmark Condition (Original Corn-Tomato-Squash-Peas Rotation) 7.67 7.67 -0.48
Added cover crops & replaced peas with sorghum-hay 2.19 2.19 0.20
Added cover crops & contouring & replaced peas with sorghum-hay 0.427 0.427 0.33
Added cover crops & contouring & replaced peas with sorghum-hay & additional 1T
compost 0.424 0.424 0.34



Presenter
Presentation Notes
7.67->2.19=71% reduction
7.67->0.427=94% reduction
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Get the field management details
|dentify when soil loss occurs

|dentify potential mitigation alternatives
Changing/substituting tillage implements
Inclusion of cover crops
Adding compost/mulch
Changing crops in the rotation

Assess the effects of those alternatives
Implement the agreed-to alternative(s)



Questions?

What! You can
graph data in
RUSLE2?

United States Department of Agriculture

NdLUrdl hesources Lonservation -

Giulio Ferruzzi

Conservation Agronomist-USDA-NRCS

West National Technology Support Center (WNTSC)
Portland, OR

(503) 273-2429

USDA is an equal opportunity provider and employer.
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